YOUNG CAYMANIANSON THE ROAD TO
SUCCESS ....cont’d from page 11

Dr. Pomares is the daughter of Pedro and
Malsie Pomares. She is married to Errol
Anthony Miller and is a new mother to
six-month-old Zhane Solange.

Director of Heath Services Mervyn
Conolly says he is very proud and
pleased by the decision of both
Dr. Pomares and Dr. McLaughlin to
return home and make a contribution to
health care in the Cayman Islands.

“This is very encouraging and | hope it
will help to stimulate more of our young

A new preacher moved into town and went
out one day to visit his parishioners. All
went well until he came to one house. It
was obvious that someone was home, but
no one came to the door even after he had
knocked several times. Finaly, he took
out his card, wrote on the back
“Revelation 3:20” and stuck it in the door.

The next day after service, as he was
counting the offering he found his card in
the collection plate. Below his message
was a notation

“Genesis 3:10"

Upon opening his Bible to the passage, his
face turned red and he let out a roar of
laughter.

Caymanians to pursue careers in the
field of health care.”

He says both doctors have brought
tremendous skills and knowledge from
their training and work experiences
overseas, which will add to the high
calibre of the medical team at the
Cayman Islands Hospital.

Health Services joins in extending
welcome to Dr. McLaughlin and Dr.
Pomares to the team.

HUMOUR

A Sunday school teacher was teaching her
class about the difference between right
and wrong.

t children, let's take another
exafle, “ shesaid. “If | wereto getinto a
prian’ s pocket and take his billfold with all
his money, what would | be?" Little
Johnny raises his hand, and with a
confident smile, he blurts out, “You'd be
his wife!”

A Sunday school teacher asked the
children just before she dismissed them to
go to church, “And why is it necessary to
be quiet in church? Annie replied,
“Because people are sleeping.”

Revelation 3:20 reads; “Behold, | stand at
the door and knock. If any man hear my
voice, and opens the door, | will come in
to him, and will dine with him, and he with
me.”

Genesis 3:10 reads: “And he said, | heard
thy voice in the garden, and | was afraid,
because | was naked.”

A civil servant has told of his anger and
humiliation after a woman who said she
was desperate to marry him posted his
naked picture on the Internet.

Stephen McPherson, from Grays, Essex,
achieved cult status when millions of
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NEW ELECTRONIC
CHARTING SYSTEM GOES
LIVEIN CRITICAL CARE
UNIT

A new patient data information
system went into operation on the
Critcal Care Unit on Wednesday,
March 27.

The Spacelabs electronic charting
system automatically downloads all
information collected by the bedside
monitor of a patient and displays the
data in a chart format.

More on this new system in our next
issue of Health Services News.

A Sunday School teacher asked her class
why Joseph and Mary took Jesus with
them to Jerusalem. A small child replied:
“They couldn’'t get a baby-sitter.”

A Sunday school teacher was discussing
the Ten Commandments with her five and
six year olds. After explaining the
commandment to “honor thy father and
thy mother,” she asked “Is there a
commandment that teaches us how to treat
our brothers and sisters?’ Without missing
abeat one little boy answered, “ Thou shall
not kill.”

Submitted by Pat Bell

people around the globe saw the image of
him in his birthday suit on Vaentine's
Day.

Sarah Jay, 23, who claimed to have been
hisgirlfriend for seven years, put the saucy
photograph on the web and begged other
users to persuade him to propose.
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EMPLOYEE BENEFITS GUARANTEED IN
PROPOSED HEALTH SERVICESAUTHORITY LEGISLATION

All current benefits offered to Health
Services employees have  been
guaranteed in the proposed Health
Services Authority Legislation.
Additionally, there will be no major
restructuring of the organisation or job-
loss as a result of the transition to a
Health Services Authority on July 1.

Those are two of the key messages which
are being relayed to employeesin a series
of meetings hosted by the Director of
Health Services, Mr. Mervyn Conolly

and members of the senior management
team.

Mr. Conolly disclosed that based on
discussions with the Ministry one of the
fundamental principles agreed to is that
all employees of the Health Services
Department will not be any worst off asa
member of the new Health Services
Authority than if they had remained a
Civil Servant.

He noted that while the move to an

HEALTH MINISTER ENCOURAGES STAFF
TO DONATE BLOOD

The Minister of Health, the Hon. Gilbert
McLean, has suggested a staff blood
donor pool, as pat of a nationa
programme aimed at sensitising people
about the importance and benefits of
donating blood.

Noting that he has been a blood donor
since the 1960s, Mr. McLean says he
"knows only too well how vital blood isin

helping to save lives. It's amazing how
just one donation, given in 15 minutes,
can help to save lives," he adds.

While on a visit to the Hospital on
February 22 to donate blood himself, the
Minister issued an appeal for local
support, citing the link between blood
donation and lifesaving.

The high cost of importing blood, and the
possibility of being unable to get the
required quantity of certain blood types
when they are needed, can put lives at
risk, he continues. He further notes that
during surgery, it is important that blood
is readily available should it be needed.

The Blood Bank, the only one on the
island, isnow on adrive to build its donor
pool and increase the level of blood
supplies by encouraging current and new
donors to give blood.

Authority will have some implications,
the Health Services views its staff as its
most valuable asset and therefore is
committed to ensuring that al available
information is provided in a timely
manner.

All current employees will receive official
notification of their intended transfer to
the Health Services Authority along with
other information on new policies and
procedures which will be adopted by the
Health Services Authority as of July 1st.

For those employees who will transfer to
the Authority, there will be no change in
the substantive terms of employment and
employee benefits, including Pay,
Pensions, Health Care benefits, holiday
entitlement etc.

Mr. Conolly noted that the move to a
Health Services Authority will bring about
new and challenging opportunities for the
Health Services. He cited several benefits
which will result from this:-

e improved decision making

e improved recruitment process

e greater efficiency in operations

e service will operate as a
business

e ability to determine own staff
structure and remuneration

This month we continue to provide
answers to the questions which many of
you have submitted on the proposed
Health Services Authority.

Turn to page 5 for all the answers to the
guestions you asked about the proposed
Health Services Authority.
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It's cricket lovely cricket

It'stime for cricket, lovely cricket. Come out and support the Health Services
Cricket team as they vie for championship honours in this year's domestic
club competition.

Below is the schedule of games and their location. All matches begin at 10:00
am. The team needs your support. Please come and cheer them on.

Saturday, March 9 Health Services vs. West Bay Smith Road
Saturday, March 16 Health Services vs. Cayman Brac Smith Road

Saturday, March 30 Health Services vs. Paramount Smith Road

Saturday, April 13 Health Services vs. Greenies Too Smith Road

Saturday, April 20 Health Services vs. Roraima Smith Road
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As employees of Health Services, we are
more aware than most of how important
our health is. In order to support all our
staff in maintaining and improving their
health, the Workplace Health Promotion
Programme (WHPP) will be launched at
the end of March 2002.

In 1986, the World Health Organization
recommended a move away from
individual based health promotion
towards the need to acknowledge the
influence of the wider environmental
‘settings’ in which we live and work.
The workplace was identified as one of
those settings.

A wide range of scientific research has
demonstrated the possible health and
financial benefits from a WHPP.

The Cayman Islands Health Services
recognised the potential to improve the
well-being of the Cayman population
through such programmes, and provided
funding for two members of staff to
attend training in the US so that
effective WHPPs could be implemented.

The first WHPP will be piloted with
you, Health Services staff. The initial
step in developing a WHPP is to assess
staff’s health. This assessment was
carried out with 222 staff members
completing the questionnaire.

The data from the assessment was split
into three areas:

1. Early detection (self-examination and
screening)

2. Mental/emotional and social health
3. Lifestyle

As advised by the American Journal of
Health Promotion, the WHPP is based
on the Transtheoretical Model of
behaviour change.

In summary, this model acknowledges
that when people make any changes in
their life, they go through a series of
stages.

The model emphasises how important it
is to target health promotion depending
on where in this cycle of change a
person is.

The am is to support a person in
progressing from one stage to the next.

It takes a realistic view that people do
not make behaviour changes over night,
and that priority should be placed on
supporting and enabling people to make
the changes they want to make.

Below is a selection of the results from
the staff health assessment (for a copy of
the results report contact Sarah Diggle):

. 72% of female participants
have regular pap smears (at least
every 2 years);

. Only 35% of females aged over
40 years have an annual
mammogram;

. 20% of males have had a
screening test for prostate cancer;

. Over a Y of the participants

feel stressed frequently, 59% feel
stressed sometimes;

. 84% of participants are
currently attempting to reduce stress
levels;

. 90% declare that they find
meaning in their life all of the time,
or most of the time;

. 40% have exercised (3 times a
week for at least 20 minutes each
time) for more than 6 months; 52%
are in the cycle of change (intend to
start exercising in the next 30 days —
6 months);

. Only 49% feel that they are
within 15lbs of their ideal weight;

. 75% are already trying to, or
intend to lose weight.

The assessment also showed that there
was enthusiasm amongst staff for a
WHPP, with 75% claiming that they
would participate.

The assessment results have been used
by the WHPP Working Group to devise
an action plan of activities with the aim
of improving staff health.

Upcoming WHPP projects are:

1. Staff Birthday cards (starting
April/May 2002)

Keep a look our for your birthday card
with health messages!
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2. Breast health information (starting
May 2002)

Keep checking your email for breast
health information or ask your section
supervisor for information

3. Prostate/testicular health
information (starting June 2002)

Keep checking your email for breast
health information or ask your section
supervisor for information

4. Beat the stress & Cope with Change
wor kshops (starting April/May 2002)

Due to rising stress levels, don’t miss
these workshops provided by EAP. Also
included will be ‘how to cope with
change’, as this becomes increasingly
important as we become a Health
Services Authority.

5. Weight Management Counselling
Sessions (starting April 2002)

Want to lose weight? Need help?
Make an appointment with the
nutritionist at the Specialist Clinic by
calling ext. 2530 or at the GT General
Practice by calling ext.2800.

6. Nutrition Education Sessions
(starting June 2002)

Don’'t miss these interesting sessions,
which will give you all the information
you need about healthy eating.

The first Nutrition Education Session
will be held in the Hibiscus Conference
rooms 8am until 9am on Friday June
21st. Just come along!

As 74% of you recommended that
activities should be held during both
work and non-work hours, we have
requested supervisors to accommodate
staff attending WHPP activities during
work time wherever possible.

Don’t forget the date mentioned in this
article. For any further details about the
WHPP, please contact Sarah Diggle at
ext. 2632.

Strategic Plan for Health Reviewed

The Heath Services Department
recently undertook a major review of the
National Strategic Plan for Health to
ensure that the plan still remains current
in a changing environment.

The Cayman Islands Strategic Plan for
Health was devel oped between 1994 and
1997, reviewed in 1998 and 1999 and
approved in its current form by
Executive Council in October 2000.

At this Planning Session, 28 Planning
teem  members  were  present,
representing the Government Health
Services, the private sector and the
public in general from both Grand
Cayman, Cayman Brac and Little
Cayman.

The group met on Friday, February 22 at
the Holiday Inn to review the progress of
the plan's implementation and, if
necessary, to develop new strategies and
action plans for the way forward.

Minister of Health Services, District
Administration and Agriculture, Hon.
Gilbert McLean who delivered the
opening address spoke of the individual
responsibility of every resident in the
Cayman Islands to ensure the
sustainability of a quality health care
system.

"There are several reasons for this; first
and foremost | strongly believe that the
future of aquality health delivery system

requires to a large extent the |-

involvement of everyone" he said.

1 Mr. McLean

expressed the view
that "one way of
dealing with the
increasing cost of
providing healthcare
within the Cayman
Islands, is to
establish a health
care delivery system

that is based on
individual
- responsibility.

He stressed however that government
would have to continue providing
subsidies for those persons unable to
afford such responsibilities and for
public health programmes.

The Minister drew particular reference
to Strategy 3 of the National Strategic
Plan which states, “we will encourage
each member of the community to
accept his’her  responsibility to
contribute to the maintenance of
personal and community health.”

In outlining his vision, Mr. McLean
stated that "the time and era which we
are presently in requires a different
mindset about the role government must
play in providing heath services, and
the need for organisations to work across
disciplines to achieve the same
objective."

Director of Health Services, Mr. Mervyn
Conolly commended the team for the
exhaustive work already done in
accomplishing the strategies contained
in the Strategic Plan

Mr. Conolly said he was particularly
pleased to note that many members of
the very first planning team were in
attendance and were willing to make a
meaningful contribution to the on-going
development, review and
implementation of the Strategic Plan.

Deputy Director of Health Services,
Mrs. Eloise Reid who gave a summary
of the progress made in the plan's
implementation noted that significant
progress has been made in the
implementation of the strategies
outlined in the Strategic Plan for Health.

She disclosed that 70% to 80% of the
action plans are considered either
completed or are being worked at.

Mrs. Reid also reported that nearly 70%
of the Action Steps of the Strategies
directly related to the Sister Islands were
already completed or being worked at.

She noted, however, that while
significant progress had been made in
the implementation of the Strategic Plan
there were some strategies with action
plans that were outside the control of the
Health Services Department and other
action plans that required inter-
departmental support to be pursued.

Four teams of six to seven Planning
Team members were formed to review
two strategies each and make
recommendations on the way forward.

At the end of the day the Planning Team
reconvened in a plenary session to
discuss the groups recommendations
for changes to the existing Strategic

Plan.

These recommendations will be
forwarded to Ex. Co. for approval
via the Minister for Health and
Action Teams formed to review and
develop new strategies and action
steps that will make the Strategic
.| Plan for Health more relevant to the

present reality of Health Care in the
Cayman Islands.
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News from Health and Medicine
Il World' s Population Ageing — I mplications for Health and Care Services.

The state of health in the world in general
and in particular in the European Union
and North America is better than ever
before. This is due to the enormous
progress made in the second half of the
20th Century in medical research, health
services provision and living conditions.
These in turn translated into demographic
changes characterised by increasing
numbers of older people aive. Older
people require more and different health
and care services than younger people.

In the Caribbean, despite the existing
economic challenges and where the
demographic transition to an older
population is taking place a an
accelerated pace (2), health care systems
must nevertheless meet the needs of an
increasingly older population in the future.

Presently, the majority of old people in
need of permanent assistance and care are
attended to by family members, at home.
However, in the future, the proportion of
the young and the old will crossover.
Thus, in the future, the number of old
people suffering from chronic age-related
diseases will surpass the number of young
people available to attend to their needs.
As a consequence, more professional
services will be required such as. home
nursing, old age assistance programmes,
old age nursing homes and old age
apartments (1). In addition, today’s health
preventative measures that promote a
healthy lifestyle (better nutrition and
exercise) should be seen as a cost-
effective and crucial means to extend the
number of healthy-life years. These
measures are important contributing
factors to the reduction in the number of
yearsin dependency / care of the old of the
future.

Therefore, today’s challenge for health
care policy makers is to ensure that new
health policies will provide adequate and
cost-effective responses to the problems of
an ageing population. In this context it is
crucial to balance quality of care with
costs while improving health conditions
among the most vulnerable age and
income groups in society.

Contributor: P. Rodrigues (Ph.D.) —H.S
Research Officer.

Sources:

1. European Symposium —-Towards a 2. Eldemire-Shearer D., Ageing - A New
society for al ages — European Challenge to Health Care in the New
Commission (2001).

Millennium, West Indian Med. J., 2001,
50 (2), 95-99.

What they are saying about us

Two weeks before Christmas, | was admitted to the George Town Hospital
emergency Department at 10:30 in the evening for a respiratory ailment. The
Emergency Room doctor determined that | stay in the hospital for the following five
days for intensive treatment and rest.

| want to publicly thank all the staff on the Emergency and Medical Wards at the
George Town Hospital for the wonderful care they gave me during those five days,
including the maintenance, cleaning and food services personnel. Everyone who
came into my room, at any time during the day or night, was pleasant and cheerful
and very professional. The nursing and doctors care was excellent, both in the
Emergency and Medical Wards - | knew | was in good hands at all times, starting
from the time | entered the hospital.

Y our hospital isacredit to your island and Caymanians can take much prideinit. I'm
an expatriate, living on the island for a few years, and | know that | would not have
received the same quality care in my home country.

Thank you for giving me the opportunity to express my thoughts through your
newspaper.

Christine Mills (Robb)

Dear Mrs. Reid:

| was recently a patient in your hospital. | had an emergency abdominal surgery for a
small intestinal blockage. | was in the hospital for aimost 2 weeks.

From the time | entered the hospital via the emergency room, | received excellent
care. | was placed on the surgical floor. The nurse who took care of me were smart
and very caring.

| believe | received better care here than | would have gotten in the USA.

When | turned my light on (nurses call button), it was answered within 2 minutes. |
never had anyone answer my light who was not nice to me. They always acted like
they wanted to help me.

| am getting a little stronger each day thanks to the excellent care | received at the
G.T. Hospital from the Nurses and from Dr. Bromley.

Sincerely

Carolyn Nichols.
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April 7, 2002 is World Health Day and
this year’'s World Health Organization
(WHO) slogan is Move for Health.

This is a call to individuals, communities
and countries to associate physical activity
with the prevention of diseases and the
consequent gain of a longer and healthier
life.

The WHO estimates that by 2020 non-
communicable diseases will cause over
70% of the global burden of disease.

Non-communicable diseases are those
acquired over a period of time due to what
we eat and how we live.

These diseases are not only affected by
individual behaviour but aso by poverty,
violence, rapid social and economic
changes, lack of education, inadequate or
total lack of health services and lack of
clear health policies.

The WHO estimates that worldwide the
lack of physical activity leads to more than
two million deaths per year.

The WHO aso estimates that, a
combination of improper diet, insufficient
physical activity and tobacco use are the
cause of up to 80% of al premature
coronary heart diseases.

Lack of physical activity and consequent
obesity substantially increases the risk of
high blood pressure, lipid disorders,
osteoporosis, depression, anxiety, type Il
diabetes and cardio-vascular diseases.
Obesity is now a maor public health
problem in North America, many Latin
American countries, the Middle East, Asia
and the Western Pacific Islands.

Just in the USA, obesity causes an
estimated 300 000 deaths annually, this
number is only exceeded by deaths related
to tobacco use. In China, an estimated 200
million people could become obese in the
next ten years.

Despite the health problems linked to lack
of physical activity and obesity, the secret
of good health has been known for a very

World Health Day 2002
Be active, Stay Healthy

long time, as good eating habits
combined with adequate exer cise.

Today there is enough epidemiological
information suggesting that moderate
exercise combined with an adequate diet
can reduce the occurrence of non-
communicable diseases such as. heart
attacks, strokes, type Il diabetes and some
forms of cancer.

Studies in various countries suggest that
moderate changesin lifestyle are sufficient
to prevent the development of amost 60%
of type Il diabetes cases. Also, one-third of
cancers can be prevented by maintaining
throughout life a healthy diet, normal
weight and physical activity.

&

)

At both the individual and social levels,
physical activity can be a practical means
to achieving health gains such as:

- lowering the rates of violence among
young people and promoting a
tobacco-free and drug-free lifestyle,

- reducing feelings of isolation and
loneliness among older people and
improving their physical and mental
agility,

- reducing obesity in al age groups
and consequently the burden of non-
communicable diseases associated to
it.

What is physical activity?

Physical activity is the expenditure of
energy through body movement such as
walking, climbing stairs, dancing,
swimming, skating, etc.

Why is physical activity important for
one's health?

Physical activity isimportant asit prevents
and controls several non-communicable
diseases such as; cardio-vascular diseases,
type Il diabetes, obesity, osteoporosis, etc.
Being physically active increases one's
energy level, helpsto reduce stress, lowers
unhealthy cholesterol and blood pressure
and reduces the risk of some forms of
cancer.

Physical activity promotes healthy growth
and development in children and young
people, increases self-esteem and the
feeling of achievement and improves the
quality of life and independence of older
people.

How much physical activity do | need in
order to improve and maintain my
health?

The minimum suggested is 30 minutes of
moderate activity everyday.

Remember: We all need to be active to
stay healthy.

Contributor: P. Rodrigues (Ph.D.) — H.S.
Research Officer.

Sour ces:
1. WHO - World Health Day 2002 —

Move for Health.
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Wecomel

This column is intended to give new users
of Microsoft Outlook 97 important
information to help maximise satisfaction
and minimise frustration. Take the time to
read and understand this information. If
you have any questions, contact the Help
Desk.

Your Mailbox

Y our “mailbox” is aplace in our computer
system assigned to you to store your
Outlook-related  information. Y our
mailbox contains different folders for each
type of information. These foldersinclude
an Inbox for incoming mail, a Sent Items
folder for mail you have sent out, a
Calendar for your appointments, a
Contacts folder for names and addresses
and several other folders. Your mailbox
also includes a Deleted Items folder that
temporarily holds Outlook items that you
have deleted, until you “take out the trash”
by emptying your Deleted Items folder.

We have alot of Outlook users, but only a
limited amount of space on our computer
system. For this reason, each person’'s
mailbox is has a maximum capacity. That
way, everyone has an equal share of the
computer system and no one person can
take more than their share of space. It is
important to manage your Outlook-based
information to make sure your mailbox
doesn’t fill up. When your mailbox isfull,
Outlook will prevent you from sending
any email messages until you remove
some items from your mailbox.

Each night, Outlook checks to see how full
your mailbox is. If itiscloseto being full,
you will receive one or more messages
from Outlook indicating that your mailbox
is nearing its maximum capacity and
asking you to reduce the size of your
mailbox.

Once your mailbox isfull, you will receive
further messages each day, and you will be
unable to send any emails until you reduce
the size of your mailbox below the
maximum allowed size.

Remember that your mailbox consists of

all of your Outlook folders
including Inbox, Sent
Items, Deleted Items,
Calendar, Contacts,
Journal, Notes and any
additional folders that you
created within Outlook.

When you start receiving

warning messages, you should take steps
immediately to reduce the size of your
mailbox. Here are some pointers on how
to do this.

1. Empty the Deleted Items folder.
Right-click the Deleted Items folder and
click on “Empty Deleted Items Folder”.
Items that are deleted from folders are not
immediately removed from the mailbox.
Instead they are moved to the Deleted
Items folder which is part of the mailbox,
therefore they continue to take up space.
After deleting any items from any folder,
you must also empty the Deleted Items
folder to completely remove the items and
free up space.

2. Check for very large file
attachments. Most Outlook items such as
emails and appointments are very small in
size. But emails can sometimes contain
attachments that are very large in size.
Here is atechnique for showing the size of
each email item, in order to find very large
attachments.

You should use this technique in your
Inbox, your Sent Items folder and any in
history folders that contain mail items. On
the View menu, click Show Fields. Then
click “Size”, the Add button and the OK
button. Click on the Size column heading
twice to sort by size in descending order.
Check for large items (ie. over 1 Mb in
size) and delete them if possible.

If you wish to keep the attachment, save it
to your U: drive before deleting it from
your mailbox. Repeat these steps for each
mail folder listed above. Remember to
empty the Deleted Items folder afterwards.

3. Run the auto-archiver. Outlook
will periodically archive old items based
on user-defined auto-archive settings.
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Archiving will move the old items out of
your mailbox and into another area called
your archive. Outlook periodically
prompts you to run auto-archiving, but
you can tell Outlook to run it immediately
when you want to free up space in your
mailbox right away. On the File menu,
click Archive. Click “Archive all folders
according to their auto-archive settings’,
then click “OK”.

4, Empty your Journal folder. Most
people do not use the Journa folder,
which contains an entry for every Word or
Excel document editing session. To
empty this folder, click Journal on the
Outlook bar, then click Edit > Select All,
then Edit > Delete. Remember to then
empty your Deleted Items folder to
complete remove the items and free up
space in your mailbox.

Profiles

Your mailbox is stored on our Windows
file server, not on any individual PC. You
can access your mailbox from any PC that
has an Outlook “profile” set up for you.
The Outlook profile tells the PC where to
find your mailbox.

You must ask the Help Desk to set up an
Outlook profile on each PC on which you
wish to use Outlook. You will not be able
to use Outlook on a PC that does not have
aprofile set up for you.

Once an Outlook profile has been set up
for you on a PC, you can use that PC to
access your mailbox. If you use a PC that
is shared by other users, you will have to
select your name from the list of profiles
available on that PC when starting
Outlook. If you are the only user on the
PC, your profile will be selected
automatically.

Here are the answers to the many
questions submitted by you about the
proposed Health Services Authority.

1. Will there be any cuts jobs/pay/
benefits?

The Health Services Department values its
employees as its most important asset and
will do everything to protect employee
benefits. In discussions with the Ministry,
agreement has been reached on five key
human resource principles which include
the protection of salary and benefits.

HR Principle 1: Thisprincipleisthat for
the 1st July implementation, there will be
no major restructure of the organisation or
job-loss. It will not preclude re-
organisation at a later date, but will
exclude any major re-organisation or job-
loss to be made on 1.7.02.

HR Principle 2: Thisprincipleis, that in
the absence of any Employment Protection
Legislation, then al employees of the
Health Services Department and those
contracted for the provision of services
will be given new contracts of
employment with the Health Services
Authority from 1.7.02

HR Principle 3: This principle says
there will be no change in the substantive
terms of employment for those transferring
on 1st July. Substantive terms are those
that affect the pay or benefits enjoyed by
the employee, including Pay, Pensions,
Health Care benefits, holiday entitlement
etc. Once again, this will not preclude
subsequent review but will prevent change
occurring on 1.7.02.

HR Principle4: This principle  will
allow changes to be made to the non-
substantive terms of employment for al
HSA employees from 1st July. The non-
substantive terms are behavioural and
performance rules, disciplinary and
grievance procedures etc.

HR Principle5: This principle will
allow for new terms to be introduced for
those starting after 1st July, where
appropriate and practical. This principle
will require that such new terms as
introduced for new starters for 1st July,

will not disadvantage those transferring,
nor will they disrupt the future
introduction of new terms applying to all
employees of the Health Services
Authority.

2. What policy if any, will be put in
place to ensure that the C.O.S. will not
be reborn/continuein it's existing form
or some mutated form thereof?

His Excellency, the Governor, Mr. Peter
Smith has signed an Executive Order
which will abolish the payment of
Contracted Officers Supplement (C.O.S)
to overseas contracted workers as of July
1, 2002.

This was done to bring expatriate public
servants employed on overseas contractual
terms more in line with the terms of
service of Caymanian public servants. The
C.0.S payment will be replaced by the
defined contribution pension arrangements
offered to new Caymanian and local
contracted public servants since 1st
January 2000. This new policy aso fulfils
the requirements of the National Pension
Law.

3. What will the organisational chart of
the authority look like?

The Authority will have a Board of
Directors (6-8 persons) chosen by the
Governor and the Permanent Secretary in
the Ministry of Heath, the DHS, CMO
and the Medical Officer of Health will also
sit on the Board. This Board will be
responsible to the Ministry for its actions

As agreed with the Ministry, there will be
no major restructure of the organisation on
the 1st of July. A few changes in titles
have been proposed to reflect the change
from a Department to a statutory authority.

4. \Who makes the " final" decisions?

The Authority will have a Board of
Directors, as provided for in the Law. The
Board will be responsible for and have the
full power and authority over the policies,
direction, management and administration
of the property, affairs and business of the
Authority in the exercise of its functions
and duties and with full powers of

delegation.

5. How/Will cost of living increases be
determined/given?

While the Authority will have its own
decision making authority, through the
Board, it will be guided by the
Employment Relations Law. However
these details have not been determined as
yet. As soon as the Board is set up these
policies will be developed and shared with
the Staff.

6. What isthe plan for health insurance
for us?

According to the Law the employees of the
HSA will be entitled to receive the same
medical benefits provided to them
previously by the government, provided
that if the government shall change the
terms of medical benefits to public
servants, the authority may elect to amend
in like manner the medical benefits of the
public servants transferred from the
government.

7. Will any consideration be given to
allow pensionsto continueasis, instead

of freezing them as it currently stands?

It is the intention of the HSA to continue
to contribute funds equal to the sum
currently contributed by government to the
Public Servants Pension Scheme for all of
its employees. This will allow employees
to maintain their current pension status
without losing any benefits offered by the
scheme.

8. How will the terms of employment
change for PP staff?

The substantive terms (salary, vacation
and other leave etc), of employment for
the PPE staff will not change. However
they will no longer be civil servants but
rather employees of the Authority and
therefore the role currently played by the
Public Service Commission will revert to
the Authority Board. In light of this
situation the Authority will have to
develop its own disciplinary procedures,
hiring practises etc utilising the new
employment Law as the framework.
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9. Will PP officers get official notice
from the personnel unit now under the
government before July 1, if not will we
be paid three months salary as per
general orders if we are not given
proper notice?

Official notice will be given to staff as per
the General Orders apprising them of their
transfer to the Authority. Staff not wishing
to transfer will then have time to seek
aternative work should they not wish to
work for the Authority.

10. Can PP staff remain under the
present pension plan if no why?

Yes. It is the intention of the HSA to
continue to contribute funds equal to the
sum currently contributed by government
to the Public Servants Pension Scheme for
al of its employees. This will allow
employees to maintain their current
pension status without losing any benefits
offered by the scheme.

11. Will my health plan change under
the health authority?

According to the Law the employees of the
HSA will be entitled to receive the same
medical benefits provided to them
previously by the government, provided
that if the government shall change the
terms of medical benefits to public
servants, the authority may elect to amend
in like manner the medical benefits of the
public servants transferred from the
government.

12. Will we still be using general orders
as a guideline for personnel issues?

The Authority will be developing its own
personnel policies utilising the new
Employment Relation Law as its guide.
This Law is expected to supersede the
General Orders.

13. Can a person leave the Health
Services next year July, at age 50 years
and receive their pension at that time

since they will be frozen?

There are no plans to freeze pensions.
However the Public Services Pensions
Plan makes provision for early retirement
from the Plan. When you reach the age of
50, aslong as you have at |east ten years of
Qualifying Service you can be considered
for early retirement. However your
pension would be on a reduced basis.
Refer to Section A: The Defined Benefit
Part ,pages 4-5

14. What is the ratio/percentage that
will be withdrawn from a person's
salary monthly as of July 2002 and
added to the pensions?

The Public Service Pension Scheme for
current Civil servants is funded by a
government contribution of 6% and staff
6% (12%) to the scheme. However, staffs
basic salary remains the same as
government adds the staff pension
contribution to their monthly salary. It is
then deducted to the pension plan. In
essence government pays the full 12%
(their contribution and staffs).

15. Pension contributions: if we have to
change, how is it going to be done? So
far, Govt. has in fact paid the full
amount (12%) that goes to the Pension
Fund. How is it to be done in the

future?

There are no plans to change the pension
contributions.

16. Retirement: Can those who wish to
retire do it without having their
pensions frozen until age 60 or 657

The Public Services Pensions Plan makes
provision for early retirement from the
Plan. When you reach the age of 50, as
long as you have at least ten years of
Qualifying Service you can be considered
for early retirement. However your
pension would be on a reduced basis.
Refer to Section A: The Defined Benefit
Part ,pages 4-5

17. Will we still be under Government’s
“General Orders’?

The Staff of the Authority will be expected
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to follow the policies and procedures of
the HSA as they will no longer be civil
servants and under the jurisdiction of the
public service.

18. Any progress on new schemes for
Health Insurance?

It is not expected that a new scheme will
materialise before year end. The Mercer
Group contracted by government to
explore the concept of implementing a self
funded health plan will be fulfilling its
terms of reference in a phased manner. The
report for Phase 1 is due on the 15th March
2002, Phase 11 in May 2002 and phase
111 will consist of procuring the services
of athird party administrator to administer
the agreed plan.

19. Will there be career paths for all
staff?

The health service will have to abide by
the Government and Immigration policies
and as such will have to continue to
support the concept of Caymanisation.
However, in the absence of qualified
Caymanians other serving officers would
be entitled to apply for vacant positions.

20. Will we stay under the existing
Government salary scales and

increment system?

Officerswill transfer into the Authority on
their same salary scale. The Authority may
opt at a later date to develop its own
salary scale but there are no imminent
plans to change same.

21. There is a rumour going around
that overseas contracted officers will
losetheir C.O.S. and that they will have
to pay 6% toward their pension, in
effect making their monthly take home
pay 21% less. | do not understand this
to be the truth but am asking you to
confirm this?

It isafact that overseas contracted officers
will lose their benefit of COS at the end of
their current contract. All contracts offered
to staff (new or old staff) on ,or after July 1

2002 will include pension benefits instead
of COS. The basic salary for officers
currently receiving COS will remain the
same, as government will fund the 12%
pension benefit.

22. For persons on a local contact (ex-
pat) what will happen to the current
pension? Specifically will it be frozen
until the individual retires? (65 years).
Or will that individual be able to access
the money accrued on cessation of
employment as a civil servant, i.e. July

1st?

The Public Service pension plan makes an
allowance for expatriate officers to receive
their pension contributions and any
accrued interest at the completion of their
contracts. However this will be paid 30
days after they have left the island.

23. Will Pharmacy be allowed to run as
a business & generate an income
payable direct to the section, allowing
investment in resources in the event of
increased workload?

The Board will determine any resource
investment of the Authority. All fund
collected by the sections will become part
of the operating budget of the Authority .
Sections will have the privilege to submit
request for equipment and supplies justify
needed

24. Please can you clarify the position
on the COS and pension situation (with
regards to the Memo sent from the
Permanent Secretary on 31/1/02) - will
the employee loose the 15% COS and
have to also contribute 6% from their
pay check, i.e.: atotal loss of 9% and a
21% decrease on current monthly take
home pay?

Refer to response to question # 21.

25. Will their be any changes in the
current terms and conditions for staff
having to sign a new contract from 1/7/
02, other than C.0.S.?

When will the contracts be available to see

the terms and conditions for staff who
have to renew in order for this to be in
effect on 1/7/02. and if not what will
happen if you have agreed to stay and sign
in principle and on 1/7/02 the terms and
conditions are different from what has
been speculated and you no longer wish to
take up the contract. Staff who are in the
position at present and have to decide
whether to renew or terminate need
something to base their decision upon
apart from speculation.

There will be no change in the substantive
terms and conditions of staff as a result of
the transfer to the Authority. However as
the staff will no longer be civil servants
the rules of General Orders will not apply
to them. Staff will be made aware of the
Authorities policies and procedures by the
28th March 2002. The HRM is currently
drafting these new policiesin keeping with
the new Employment Relations Law,
which is to come into effect by July this
year.

26. Can staff back date their contract
renewal date to start before the 30th of
June by forfeiting and giving back AL
to the Govt or negotiating something
else?

Thisisnot possible. Staff will not lose any
benefits by becoming a member of the
Authority. The move to an Authority was
not intended to disenfranchise any officers
but rather to allow the service to become
more efficient in carrying out its goals and
objectives. This hopefully will reduce staff
frustrations with operating within the
confines of the government bureaucracy.

27. Will we be required to have work
permits? If yes, will they be 1 or 2 year
GOL’s?

Staff will be required to have work permit
just as they do now. However the service
would be exempt from the immigration
requirement for professiona fees for its
staff. The HR section will prepare the
necessary document for the work permits.

28. Staff members continued education
programmes. How will it effect them,

including those who are currently
enrolled in courses?

Will current contract issues run until the
expiry of that contract? e.g. salary, COS,
return passage & baggage arrangements
etc.? Yes. See above

29. Staff with long term service, due
long term service awards, continue to
be candidates for them?

Yes. There are no plans to change this
arrangement.

30. Will the Authority continue to pay
the 'employees’ 6% as the Department
does now?

The staff will transfer to the Authority on
their same terms and conditions of service.
Therefore the Authority will continue to
contribute to the pension scheme to the
same amount as the government currently
is contributing.

31. Will the provision for leave passage
and baggage arrangements in current

contracts be changed?

The return air fare for overseas contracted
employees and recognised dependents
between renewed contracts will continue.

32. Will current overseas contracted
officers  receive the  proposed
resettlement allowance on renewal of
contract?

The one off month’s pay as a resettlement
allowance will only be payable to those
arriving from overseas for the first time to
take up a NEW contract from 1% July
onwards.

HEALTH SERVICES
ANNIVERSARY

In next month’'s issue of Health
Services News we will provide a full
report and photographic highlight of
some of the activities which were
held in March as part of Health
Services Week.
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